ince its earliest days—about 14 years ago— Access has been a rela-
tional database program, storing data in tables and using its own

THIS CHAPTER

queries, forms, and reports to sort, filter, display, and print data. With A brief history of Office data
successive Office versions, moving data among Office components (espe- exchange
cially Word, Excel, and Outlook) has become so much easier that it is now
often more efficient to use another Office component rather than an Access Storing data in Access

report for a task such as printing letters or analyzing numeric data. Displaying Access data in forms

Additionally, using other Office components to display or print data from AT LD

Access makes the data stored in Access tables more widely accessible. Many Working with rich text in
Office users have an edition of Office that doesn't include Access— but they Memo fields

all have Word and Excel, and many also have Outlook, so they can easily

work with Word documents, Outlook messages or appointments, and Excel New report interactivity

worksheets, filled with data from Access tables. .
Using Access as a control

center for working with

Whether you plan to present your data as an Access report, PivotChart, or .
Office documents

PivotTable; or a Word document or Excel worksheet, the data is stored in
Access tables, and entered and edited in Access forms.

A Brief History of Office
Data Exchange

As the Windows operating system has progressed from Windows 3.0 to
Windows XP and Vista, data transfer techniques have improved, from simple
cut and paste using the Windows 3.0 clipboard, to Dynamic Data Exchange
(DDE) and Open Database Connectivity (ODBC), to Automation (originally




The Office Components and What They Do Best

called Object Linking and Embedding [OLE], then OLE Automation) and Extensible Markup
Language (XML).

In early Windows and Office versions, DDE and ODBC were difficult to use, cranky and unreliable
in operation, and ODBC in particular often required elaborate setup. I know —I used both DDE
and ODBC, when they were the only connectivity tools available. But I gladly dropped them when
OLE became available in Windows 95/Office 95, because it offered a much simpler way to connect
Oftice applications, though at first only in a limited manner.

Before Office 97, there was a distinction between Office components that were OLE servers, which
could be manipulated by code running from other applications, and OLE clients, which could
work with objects in OLE server applications’ object models. Back in the days of Access 1.0 or
even 2.0, Access developers had few tools available for connecting to other Office applications
such as Word or Excel. Access, for example, was only a client, whereas Word was only a server.

In Office 95 AccessBasic was upgraded to standard Office VBA, and Access became an OLE server
(previously it was only an OLE client). By Office 2000, all the major Office applications (Access,
Word, Excel, Outlook, and PowerPoint) had been upgraded to support Automation both as clients
and servers, so the OLE server/client distinction is no longer significant.

You can write Automation code in any major Office application to connect to any other Office
application’s data and functionality (and some third-party applications as well).

Storing Data in Access

Access was designed from the start to store data, so (if you have a choice — which is not always the
case) it is the place where you should store your data. You may need to use that data to produce
Word letters, SharePoint lists, Excel worksheets, or Outlook mail messages, but the data itself
should be kept in Access tables, unless there is a very strong reason to store it elsewhere.

3OS

ey m e One valid exception is storing data in SQL Server back-end databases, using Access as
*=i= the front end. SQL Server is usually the choice for huge corporate databases, not small-
to medium-sized databases used by individuals or small companies, where Access can easily handle
the number of records. See Chapter 18 for more information on this option.

Data entry and editing, too, should be done in Access, for the most part, because you can create
Access forms that offer an attractive interface for entering and editing data. You can write VBA code
that runs from form and control events for purposes of error handling, and create functions that
automate repetitive data-processing operations.

In my earlier book, Expert One-on-One Microsoft Application Development, 1 discussed creating
Access applications, with details on using queries, forms, reports, and code. I won't duplicate this
information here, but instead in this chapter I concentrate on new or improved features in Access
2007, which enhance the utility of Access forms and reports.
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Displaying Data in Access Forms and
Reports

Sometimes you don't need to go outside of Access to present your data— if you are designing an
Access application, displaying data in forms and printing it in reports may be all you need.

¥ Over the years, Access forms and reports have been significantly upgraded. In Access
- i 2007, one long-requested feature has finally arrived in a workable form (I recall an
early and unreliable implementation that made a brief appearance in Access 95). Memo fields can
now store and display rich text, using the Text Align property, which takes a value of either Plain Text
or Rich Text. When you select Rich Text for this property, you can apply various fonts, colors, and
other attributes to selected portions of text in a table field or a control bound to that field.

In earlier versions of Office, if you wanted to generate a letter or other document including a block
of text with color, bolding, or other attributes applied to selected words or phrases within the
block, you had to create a Word letter and use Word’s formatting features. In Access 2007, you

can produce Access reports with varied formatting within text blocks, displaying text entered into
Access memo fields in a textbox on a form.

The sample database for this section is RichText.accdb.

To create a field that can store data in Rich Text format (behind the scenes, this is done using
HTML code, but you don’t have to worry about writing the code), start by creating a table field of
the Memo data type, and selecting Rich Text as the Text Format value (see Figure 1.1).

FIGURE 1.1

Creating a Memo field to hold Rich Text data.

B thiRichText

Field Name Data Typi Description
LAl AutoNumber
LetterBady Memo

Field Properties

[General Lookup)
Format
Cagtion [
Default Valug
Vahdation Rule
Valdatian Text Chiose Rich test to store text a5 HTML and
Required Mo allawy rich format in test to
Mlow Zera Length fes
Indexed o

store oaly test, Ay g et If data
might be used In Microseft OFfice Acress 2003

Unicade Compressian  Yes or earlier.

IME Mode Mo Control
IME Sertence Mode  Mone

Smart Tags

Text Farmat Plain Tesy

Test Align Pisin Text -
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If you select a block of text in a Rich Text-enabled Memo field, you will see a floating
i toolbar that lets you apply some formatting, including indenting or outdenting, similar
to Word (this works fine; see Figure 1.2). However, if you apply bullets or numbering from this tool-
bar, you will get the bullets or numbers, but the text that runs over one line won’t be indented prop-
erly, as shown in Figure 1.3. For this reason, | recommend against using these features, unless all the
items on your lists are no more than one line in length.

FIGURE 1.2

Indenting text from the floating toolbar in a Rich Text field.

Filease rum off the heat upon tsing on the momnmg of the project {pipes,
boiders, or ot water heaters).

Fumaces or boil A with Ashestos insulati ial, which

B o F. oaject, rad 10 contscl TIMes Hew Roman -0 - IH 4 |EF 3

1y ¥ 1y
independznt VAL service company. electucal contracter, oryeus| g 7 A - % -[E = = 1=
compary, to restors service to the unst. It is probable that the boilel, = =
fuzmace, and hot water will be off during the duration of the project.

LS

FIGURE 1.3

Incorrect indentation of an item in a numbered list in a Rich Text field.

I. Fumnaces or boilers covered with Asbestos msulation matenal, which
are inchuded in the abatement project, may not be operable after the
sbatement for any number of reasons, and you may need to contact an
independent HVAC service company, electrical contractor, or your oil
company, to restore service to the unit. It is probable that the boiler,
furnace, and hot water will be off during the duration of the project.

Create a form bound to the table with the Memo field; you can now enter data into this textbox
control and format it with different fonts, color, bolding, and other attributes, as you would while
working in a Word document. When you place the cursor into a control with Rich Text enabled, a
formatting group on the Form Ribbon is enabled, with a variety of formatting selections, as shown
in Figure 1.4.

Figure 1.5 shows the form with a variety of formatting attributes applied to the text in the textbox.
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Selecting formatting for a portion of text in a Rich Text-enabled textbox on a form.

| .
i ‘F RETE
b | ™ || A win

caiorn = New X Totaks
2 Hsa: W sosing

| REMesn | % Detste + == uare

= | o | Text Highight Color

Make text look like it was marked
with a highlighter pen.

FestDemo

Letter Body: | Mow Is the time for oll good men to come to the aid of their »
party. Mew is the time for all good men to come to the aid of
their party. Mow is the time for all good men to come to the
aid of their party. Mow I the time for all good men to come
to the aid of their party. Now is the time for all good men to
come to the aid of their party, Now is the time for sl good E
men to come to the aid of their party. Now is the time for all
good men to come to the aid of their party. Now is the time
for all goad men to come to the aid of their party, Now is the
time for all good men to come to the aid of their party, Mow
Is the time for all good men to come to the ald of their party.
Now is the time for all geod men to come 1o the aid of their

Recorc: M 4 [LoFl | b | 0 rch

A Rich Text-enabled textbox with a variety of formatting applied to portions of its text.

Letter Body: |Now is the time for all good men to come to the aid of their
party. Now is the time for all good men to come to the aid

of their ]J}I]'t} Now is the time for all good men to come to
the aid of their party. Now is the time for Bllgaed men to come
to the aid of their party. Now is the time for all good men to
come to the aid of their party. Now is the time for all good
men to come to the aid of their party. NOW 18 the time
for all good men to come to the aid of their
PArty. Mow is the time for all good men to come to the aid of
their party. Now is the time for all good men to come to the aid
of their partv. Now is the time for all zood men to come to the

Record: M« [1of1 oMb
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Once you have applied formatting to the text on a form, you can create a report based on the table,
and the formatting will display on the report as well (see Figure 1.6).

FIGURE 1.6

A report showing Rich Text formatting applied in a textbox on a form.

' iptRichTexDemo

Wednesday, October 18, 2006

E Rich Text Demo Report 3:01:39 P

Mow iz the time for ol good men to come to the aid of their party. Now is the lime for all gEIlld men

to come to the aid of their party. Mow is the time for all good men to come ta the aid of their party.
Mow I the time for all good men to come to the aid of their party. Mow 15 the time for all good men to
come to rPu.- aid of their party. Now is the time for all good men to come to the aid of their party, Now
is the time for all good men to come to the aid of their party. Howisthe
time for all good men to come to the ald of their party. Now Is the time for all good men to come to the
aid of their party. Now is the time for all good men to come te the aid of their party. New is the time for

all good men to come to the aid of their party.

Pagelofl

Creating Access Form Letters

A more realistic example of Rich Text formatting would be a form letter report, with the body of
the letter text coming from a Rich Text—enabled field, and the name and address information from
a table of contacts or customers. I created a table called tblLetterText in the sample database, with
a Rich Text—enabled Memo field to hold the letter body text, and an ID and a LetterType text field.
The LetterBody field holds formatted text, as shown in Figure 1.7 (the Rich Text formatting can be
seen directly in the table, though you will find it easier to create and edit the rich text in a textbox

control on a form).

I You can copy and paste formatted text from a Word document into a Memo field with
Rich Text enabled (or a textbox bound to such a field), and the formatting will be pre-

served. However, bullets and numbered lists won’t be aligned correctly, so it is best to turn off those
features before copying text to Access.

1 also created a one-row table to hold information to use in the database; in this case, it has

two Rich Text—enabled Memo fields for the letter header and signature information. The form
fdlgSelectLetter (bound to the information table, zstblinfo) lets you edit the header and signature
(Figure 1.8) and select a letter type and a contact.



FIGURE 1.7
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A table with formatted letter body text.

ID -| LetterType -
1 Pre-inspection

3 Pre-demalition

LetterBody =

IMPORTANT PROJECT NOTES

Please keep one copy and return one signed copy with signed contract

In order to ensure an efficient, neat and guality abatement, we ask that
vou review the following:

Flease be sure that the work area and aceess to the work 2rea 15 cleared of all movable
olgects.

Please make cortzin that there is adequate parking for our vehicles, a5 close as possible to
the enfranee to the work ares. Dnveways and outsade sceess ways leadmg to the work area
must be accessible and free of p items and in winter, they
must be free of snow and ice.

Flease ba cartain that vou are ot the project site when aur technicians anive. Ffyou cannot
be there, srangements must be made vath our offics m advance to encure access, in order
that we may complets your project in a timely manner, without amy additional charges to you.

30% of the total project cost should have been sobmitted along with the
sizned consract.

The balance is due and should be ready at the conclusion of the project. T vou il not be
present 2t all mes while the workl 2 m progress, it 15 very important that youleave a
telephone number with our cffice, where you can be reached. Flease call our office between
THE WORK OUTLINED BELOW IS BASED ON A PRE-
DEMOLITION SURVEY COMPLETED BY A STATE LICENSED
ASBESTOS CONSULTING COMPANY. IF THE PROPOSAL
SPECIFIES A VISUAL CLEARANCE INSPECTION ONLY AND
THERE IS NO AIR TESTING OF WORK AREAS, THE WORK
ARFAS MAY NOT BE RE-ENTERED UNDER ANY
CIRCUMSTANCES. IF THE BUILDING IS NOT TO BE
DEMOLISHED IMMEDIATELY FOLLOWING THE ABATEMENT,
ALL WORK AREAS MUST BE AIR TESTED.

ALL UTILITIES SHOULD BE KEPT ON UNTIL AFTER
ABATEM. WORK IS COMPLETED! IF ELECTRIC
AVAILABLE, WE WILL SUPPLY A GENERATOR (@ $45/d

Recard: 4 < 1of4 FH

K[ Search 4 ' »

Header Info:

Signature Block:

Your Name Here
Your Company
Street Address
City, State, Zip

Yours sincerely,

‘Your Name
Your Title

Select Letter Type:  Pre-inspection

Select Contact:

Harvey, Holly
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FIGURE 1.9

Clicking the Create Letter button opens a filtered Access report displaying name and address data
from the selected Contact record, and the letter body from the selected letter type, as depicted in
Figure 1.9.

With Rich Text formatting now supported in Access forms and reports, you may not need to pro-
duce a Word letter to get the look you want in printed documents. However, compared with Word,
Access reports using Rich Text—enabled Memo fields have one significant limitation. In Word, you
can place merge fields or DocProperty fields within a block of text, so that merged data or data
stored in document properties will print at a certain point in the text, with the surrounding text
wrapping as needed, depending on the length of the text in the fields. This is not possible with a
Memo field on an Access report, so if you need to embed merge fields or DocProperty fields within
the letter body text, you still need to create Word documents.

See Chapter 2 for information on creating Word documents of various types filled with
Access data.

A report with formatted text.

Your Mame Here
Your Company
Street Address
City, State, Zip

Sunday, October 22, 2006

Holly Harvey

B282 Warren 5t.

Bldg. 939

ML, Ashley, GA 11111-1111

IMPORTANT PROJECT NOTES

Please keep one copy and return one signed copy with signed contract

In order to ensure an efficient, neat and guality abatement, we ask that vou review the

following:
Please be sure that the work area and access to the work area is cleared of all movable objects.

Please make certam that there s adequate parking for our vebdcles, 25 close 35 possibie Lo the enlsance Lo
the work 2rea. Drveways and outside access ways leading to the work area must be accessible and free of
personal items and abstructions. Additionally, in winter, they must be free of snow and ice

Flease be cortain that vou are at the project site when our techaicians amive. i yon cannet be there,
arrangements must be made with our office in advance 1o ensire sceess, moonder that we may complete
your project in 2 timely menner, witheut any adétional charges to you.

50% of the total project cost should have been submitted along with the signad contract

The balance is dus and should be ready at the conclusion of the praject. [Fyou will nat be present at all
times while the work i5 in pragress, it is very mportant that vou leave 3 telephane musber with our affice,
where you can be reached. Flease call our office between 12:30 and 2200, so that we can update vou on the
status of the project, and give you, if possible, an estmated tme of completion. This way you can teke a
“walk through” of the finished project and then make the final payment. A dditionally cur workday zan ran
a5 late as T-00pm - 0-00pm. Therefare wou should not maks zny special plans that cannot be altered, 5o that
viu can review the project when completed.

Plrase turn off the keat upon rising on the morning of the project (pipes, boilers, or kot water heatersh

10
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Using a Naming Convention

first realized what a problem it is to work in a database with no naming convention when | took

over a database created by another programmer. The database had a table, a query, a form, a
report, a function, and five or six variables (of different data types) all called Sales (this was only one
of a number of sets of objects with the same name). This meant that when | encountered the word
“Sales” in VBA code, | had no idea whether it was a reference to a table, form, query, function, or
variable, unless the context made it clear. There were numerous errors because of the use of the
same name for different types of objects, because (among other possible sources of errors) you can
set the value of a field with a variable, or with a function—and if several variables and a function
are all called Sales, the code may use the wrong one.

You can also get circular reference errors when a control has the same name as the field to which it
is bound — which is still the case in Access 2007, when you create a form bound to a table using the
Form Wizard. To prevent these reference errors, it is an excellent idea to use a naming convention for
database objects, controls, and variables. Using a naming convention also makes your database self-
documenting (to some extent, at least), and prevents confusion when selecting an object from a
drop-down list.

About 10 years ago, | wrote an Access 97 add-in (LNC Rename.mda) to automate the process of giv-
ing the appropriate tags to database objects and controls on forms and reports, using the Leszynski
Naming Convention (LNC). This add-in was updated for Access 2000, and that version still works in
Access 2007; it is available as Code Sample #10 (for Access 2000 or higher databases) from the
Code Samples page of my web site, www.helenfeddema. com.

Creating Worksheet-type Reports in Access

If you need to produce a report formatted in familiar worksheet-type rows and columns, you can
do this with an Access report. Access 2007 reports have some new features, letting you sort and fil-
ter interactively —and if you want full interactivity, you can create a PivotTable or PivotChart form.
To demonstrate these features, I used a variation of the Northwind sample database, with objects
renamed according to the Leszynski Naming Convention.

Plain Datasheet Reports

 The sample database for this section is Modified Northwind.accdb.

g e

The query gryNorthwindall links all the tables in the Modified Northwind database. To produce
a plain datasheet report, start by selecting gryNorthwindall, and selecting Report Wizard in the
Reports group on the Create tab of the Ribbon, as shown in Figure 1.10.

11
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Selecting the Report Wizard to create a report.

Modified Northwind : Databas

External Data Diatal Add s

¥ i3] Pival Chast ]| el S Labes -.;in:: = 8
- (] Biank Form % 1 {1 Blank Repart je @ :z

Table Table

Templates -

Reporl | Query  Queiy | Masro

SharePoinl  Table (| Form  Spiit  Multiple Form
Fal Wizard Design =

~ Repoit
Lists = Destan rm  Tems o More Farms = | pacign i3, Repurt

All Access Objects il e Report Wizard
Queries & -
S amakallinvoices

Launch the Repart
helps you to create
custamized reparts,
% gmaklmvaice
R — & Press FL for more help.
H anlroices

i1 qryMerthwindall

H ansinglelraice

1 gtotirwaiceDetails

Forms #
= tagwerdinvaice

Reparts S
U3 rpcustomertabels L
8 rptinvaices

@ rpmottwing

13 rpsinglelnvaice

Macros &

2 autakeys
2 medackup
g ciPrintFittersdRer

Select the fields to include on the report (see Figure 1.11) and click Next.

FIGURE 1.11

Selecting fields for a report.

o S [
Tables/Queries .

Query: gryfiortwindAll E|
Available Felds: Selected Fiekds:
Country OrderQuarter
Salesperson Productilame
Order'fear »w | |Customer
OrderMonth * |OrderDate

1 | Price
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On the next screen of the wizard (see Figure 1.12), select the top-level grouping you want for the
report (in this case, I accepted the default selection of OrderQuarter, Customer, OrderDate).

FIGURE 1.12

Selecting a major grouping level for a report.

How do you want to view your
data?

OrderQuarter, Customer, OrderDate

Productiame, Price, CategoryMames,
Supplier

by thiCustomers

by thiOrderDetais

(%] show me mare information

cancsl | [ <gsk || mear ][ enen

The next screen lets you select sub-groups, if desired; I accepted the default (no further sub-
grouping, as shown in Figure 1.13).

FIGURE 1.13

Select sub-grouping levels for a report.

Do you want to add any grouping
levels? OrderQuarter, Customer, OrderDate

Productiame, Price, CategoryMame

Priority

cancsl | [ <gsk || mear ][ enen
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Next, select sorting and summarizing options; I selected ProductName for sorting, as shown in
Figure 1.14.

FIGURE 1.14

Selecting sorting and summarizing options for a report.

‘What sort order and summary information do you want for detai records?

You can sort records by up to four fields, in either
ascending or descending order.

1 |Productiame] B [ Ascending

: 5 (i)

Summary Options ...

cancsl | [ <psck [ mew> ][ nen

On the report layout screen, depicted in Figure 1.15, I selected the Block option.

FIGURE 1.15

Selecting the Block report layout option.

How would you like to lay out your report?

BHHK HEEE RMHK HIOEE R¥HK = 3
foitt gt st R e =
KA | MR 000 © Qutine
HEAR MM | MR M
K | KR R
RGO AN | WK O
becte bt

W KR MR

RN OO RN | WIS W
IO M| NN N
RN | REHE

AN | MRHE M

| [¥] Adjust the field width so all fields fit on
a page.

cancsl | [ <psck [ mew> ][ nen
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Select a style on the next screen, shown in Figure 1.16 (bear in mind that some of the more artistic
styles won't look good when printed on a black-and-white printer). I selected None for a plain report.

FIGURE 1.16

Selecting a report style.

Access 2003 -
Access 2007 F

HEKEERK

KK HEXX
HIHHH HHHHE

Concourse
Currency
T i t | e Deluxe
Equity
Flow
Label above Detail Foundry
Median
Metro

Control from Detail

Cancel H < Back ] Mext > l Einish

Give the report a name on the Finish screen (Figure 1.17) —1 called it rptNorthwindSales. Select
the “Modify the reports design” option to open the report in design view, and click Finish.

FIGURE 1.17

The Finish screen of the Report Wizard.

What tile do you want for your report?

rothorthwindSales

That's all the information the wizard needs to aeate your
report,

Do you want to preview the repert or modify the report’s
design?

) preview the report.

@) {Modify the report's design.

Display Help on working with the report?

o) )
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You will need to make some adjustments to the report’s design in the property sheet; if
it is not open, click the Property Sheet button in the Tools group on the Design tab of
the Rlbbon, as shown in Figure 1.18.

FIGURE 1.18

Opening the property sheet.

Report Toals

[ @ NI
il ahnlfiﬂls_‘ EICE S =%
et Lanel Eutton AP

" @ | b 'E e

Add Existing Property —
Fiekds | § :

Property Shet (Al ENTER)

pen the Froperty Shest dialag
box to configure propesties of this
page.

By default, in the Block report layout only the cells with values have visible borders, so to create an
overall worksheet-type layout, select all the controls in the Detail section of the report, and turn off
display of duplicate data values by setting the Hide Duplicates property to No on the Format tab of
the properties sheet, as shown in Figure 1.19.

FIGURE 1.19

Setting the Hide Duplicates property to No to eliminate duplicate data on a report.

Selection type: Multiple selection

=
Format | pata | Event | other | an |
Format -
Decimal Places Auto (|
Visible Ves [
Display When Alwiays
Scroll Bars None

Hide Duplicates

Can Shrink Mo

Left *
Top (1)

Width

Height 0.2188"
Back Style Transparent
Back Color #FFFFFF
Spedial Effect Flat

Border Style Sohd
Border Color =000000
Baorder Width Hairline
Fore Color #000000
Font Name Calibri

Font Size 11 -

Although it is generally not a problem for report controls to have the same names as their bound
fields (because they are rarely, if ever, referenced in code), I like to give the appropriate tags to the
bound controls at least. To do this manually, give the textboxes the prefix txt. (On a report created
by the Report Wizard, labels are named with the non-standard suffix _Label.)
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= The Report Wizard generally applies the default alignment to each column label, which

stdsef may result in inconsistent alignment. That doesn’t look good, so (if necessary) adjust the

allgnment of the column headings labels as desired (generally they should be either all left-aligned or
all centered); on the sample report | made them all centered.

If you need to adjust an individual column width, it may be necessary to turn off control grouping
(a new feature in Access 2007). To accomplish this, first select the controls in the Detail section
and click the yellow group anchor that should now be visible (though not very visible — Microsoft
should have selected a color with more contrast than dull mustard yellow) at the upper-left corner
of the group, then right-click any control in the group and select Remove from the Layout submenu
(see Figure 1.20).

FIGURE 1.20

Turning off control grouping.

|| #Page Header _

|| # OrderQuarter Header
" thetail

| Date |[Produciame
||| 6 pags Faoter =1 Tab Order..
Cut
Copy
Paste
7| Paste Formatting

ota

Align

Size

Layout Tabular
Delete [ Stacked

Fill/Back Color | Remowve

[+
For_vt"FDrtCulol| ] Gridlines
[+

Spgcial Effect Select Entire Row

' Properties Select Entire Column

Figure 1.21 shows the finished worksheet-type report.

You can interactively sort and filter a report in report view — for example, when you want to view
records from only one customer, as shown in Figure 1.22.

17



The Office Components and What They Do Best

FIGURE 1.21

A worksheet-type Access report.

Northwind Sales

Order Quarter Customer Order Date Product Price Category
1, 1995 taround the Horn 16-1an-95 Gnecchi di nonna Alice S608.00 |Graing/Cereals
1, 1995 (CQueen Cozinha 04-Jan-95 Mozzarella di Giovanni 529150 |Dairy Products
(01, 1935 Ernst Handel 23-1an-95 Mozzarella di Glovannl 556.72 |Dairy Products
01, 1995 Frankenversand 27-Jan-95 Mozzarella di Giovanni 8533.80 |Dairy Products
01, 1995 Consolidated Holdings 0 7-Mar-35 Mozzarella di Giovanni 5278.00 |Dairy Products
C1, 1995 Victuailles en stock 30-Mar-95 mozzarella di Giovanni 51,112.00 [Dairy Products
(01, 1995 Consolidated Holdings 07-Mar-35 Gustaf's Knackebrod S200.60 |Grains/Careals
1, 1995 Frankenversand 27-1an-95 Tunnbrod 5288.00 |Grains/Cerssls
a1, 1995 Ernst Handel 02-Fek-95 Tunnbrid $432.00 |Grains/Cereals
Q1, 1935 Magazzini Alimentari Riuniti 03-Feb-95 Singaporean Hokkien Fried Mee I 522.40 |Grains/Cereals
01, 1995 Seven Seas Imparts 19-Jan-95 Filo Mix £22.40 |Grains/Cereals
(01, 1995 Toms Spezialititen 17-Mar-35 Filo Mix 5840 |Grains/Careals
1, 1995 Hungry Cwl All-Night Grocers 13-1an-95 Nord-0st Matjeshering 537.26 |Seafocd
1, 1995 Split Rail Beer & Ale 02-Jan-95 Gnocchi di nonna Alice $136.80 |Grains/Cereals
01, 1935 Ricardo Adoclcados 17-Mar-35 Fletemysost 534.40 |Dairy Products
01, 1995 Raltlesnake Canyon Grocery 01-Felb-95 Gnecchi di nonna Alice 52,122.00 [Grains/Cereals
1, 1995 Galeria del gastrénoma 27-Feb-95 Gnocchi di nonna Alice S152.00 |Grains/Cereals
C1, 1995 Ernst Handel 03-Mar-35 iGnocchi di nonna Alice $912.00 |Grains/Cereals
21, 1995 Princesa Isabel Vinhos 06-Mar-55 ‘Enecchi di nonna Alice $851.20 |Grains/Cereals .

FIGURE 1.22

Filtering a report by a selected value in the Customer field.

Customer Order Date
Rattlesnake Canyon Grocery 01-Feb-35 Flatemysost
Gourmet Lanchonetes 23-Feb-95 Gorgonzola Te|
Toms Spezialitaten 17-Mar-55 Gorgonzola Tg
Santé Gourmet 18-Jan-95 Raclette Cour
Bottom-Dollar Markets 10-Feb-55 Raclette Courg
Bottom-Dollar Markets 10-Feb-95 Raclette Cour
Gourmet Lanchanatas I2-Eah g5 Rarlatte Courg
ErnstHandel | : e Cour
Prererrr—— |
Koniglich Essern e Courd
Ottilies Kaselac I Cabralg
Ernst Handel | | - Cabrald
Mére Paillarde, Manchi
— Clear filter fi Custo
Suprémes délic ) ySost
— Text Filters 3
Wartian Herkky ysost
— Equals "Gourmet Lanchonetes"
Save-a-lot Marl nzola Tel
— Does Mot Equal "Gourmet Lanchonetes”
Bottom-Dollar |
7{1 Contains "Gourmet Lanchonetes”
La maison d'Asi
; Does Mot Contain "Gourmet Lanchonetes”
Hungry Coyote mporeorore i T
Piccalo und mehr [24-san-95 |udbrandsdal
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FIGURE 1.23
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After making the selection, the report shows only Gourmet Lanchonetes records (Figure 1.23).

A report filtered by a Customer value.

B ipthorthwindSales
Northwind Sales
Order Quarter Customer Order Date Product Price Category
1, 1995 Gourmet Lanchonetes 23-Feb-05 Raclette Courdavault SE30.00 [Dairy Products
1, 1995 Gourmet Lanchonetes 23-Feb-595 (Gorgonzola Telino 514000 |Dairy Products
(02, 1996 Gourmet Lanchonetes 24-May-96 |Queso Manchego Le Pastora I 530,40 |Dairy Products
014, 1995 Gourmet Lanchonetes [17-Nov-35 [Camembert Pierrol 5340.00 [Dairy Products
Saturday, October 21, 2006 Pagelofl
.
PivotTables

If you need more advanced interactivity, you can make a PivotTable based on the same
qgryNorthwindall query. In Access 2007, the process of creating a PivotTable has been simpli-
fied; just select the data source query or table, then, as depicted in Figure 1.24, select PivotTable
from the More Forms menu of the Forms group in the Create tab of the Ribbon.
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Creating a PivotTable.

External Data

S
— —| = T==} i PwotChart "
] 8= Ll @ = _E:_E—ul | =
j Elank Form
Table Table  SharePoint | Table Form  Split  Muttiple = | Form
Templates~  Lists~ ' Design Fom  Items |2 More Forms =/ | pesign

All Access Objects
Tables
thiBackuplnfo

Datasheet

thiCategories
Modal Dialog
thiCustomers
thlEmployees PivotTable
thlOrderDetails
thiOrders
thlProducts
tbiShippers
thiSuppliers

tmaklnvoice

tmaklnvoiceDetails

3
=]
3
4
3
|
3
|
3
|
3

gmakallinvoices
amakinvoice
gmakinvoiceDetails
anyinvoices
gryMarthwindAll

arysinglelmvoice

gtotinvoiceDetails

A new form based on the data source opens in PivotTable view (see Figure 1.25), with the Field
List open so you can drag fields to the drop zones of the PivotTable, one field each to the Row
Fields, Column Fields, and (optionally) Filter Fields drop zones, which are indicated in gray text at
the upper-left corner of the form. The data field to be displayed in the body of the table is dragged
to the drop zone in the center of the form; Access will automatically create a Count or Sum field
when appropriate.

See Chapter 5 of my book, Expert One-on-One Microsoft Application Development, for
more information on creating and using PivotTables and PivotCharts.

Figure 1.26 shows the PivotTable with Salesperson selected as the Row field and CategoryName as
the Column field, with Price as the Totals field.
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GURE 1.25

A newly created PivotTable, ready to select fields.

B gryNorthwindAll

PivotTable Field List 3]
Drag items to the PivotTable list
0 gryMor thwindAll
-[F Country
=1-[F] salesperson
[#]-|=| OrderyYear

GURE 1.26

3|5

OrdzrMonth
OrderQuarter
Productame
Customer
OrcerDate
OrderDate By Wesk
OrderDate By Month
Price

Categoryhiams
Supplier

A completed PivotTable.

CategoryName =
g Condl s |Conf 'Dalrv Prod ucts'Gralns_-fcereals'MeatfPoultr\r
= = = = = 3=
= | Price - Price - Price - Price hd Price hd Price =
Andrew Fuller 2| $540.00 5176.00 $872.50 516800 504,00 $232.80 +
514400 $462.00 524430 5504.00 552500 5936.00|
$36.00 5137.50 352.35 5315.00 5151.20 $109.20
5180.00 5750.00 $52.35 5210.00 390,00 5234.00
510800 530000 $418.30 5315.00 S100.30 529,00
576.00 $1,000.00 362.82 5210.00 32240 5390.00
$14.25 $2,240.00 578.53 5375.00 5280.00 5234.00
528.50 5775.00 5534.00 5250.00 5280.00 S462.00
357.00 5194.50 $6.57 5112.00 321.00 $1,237.90
543,20 5408.45 $36.50 5540.00 58400 54,951,560
51575 466,80 564,40 5100.00 556,00 s122.79
322.50 362.24 5110.40 $6.00 5420.00 41,8565
Anne Dodsworth ;555'6 IS;;BO’E 91‘8‘3:5‘6 sﬂﬁ"ﬁ S0 giﬂﬁ's‘a
318.00 5250.00 5208.50 5340.00 356.00 331.20
5304.00 $62.50 $43.79 $52.50 5397.50 $1,237.30
$190.00 $800.00 $10.47 $250.00 $2,970.96
5100.30 $1,200.00 5322.00 312.50 $88.50 _
‘ [
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PivotCharts

Making a PivotChart is even easier: select the data source query or table and click the PivotChart
button in the Forms group in the Create tab of the Ribbon. Figure 1.27 shows the new, blank
PivotChart with drop zones at the top and right sides of the form.

FIGURE 1.27

A new, blank PivotChart.

B gryNorthwindAll

Chart Field List
Drag items to the Chart

L
=
L
2
-

o [g OrderDate By Month

- [3) rice

+-[3] Categorylame
B [F supplier

Axis Title

As with a PivotTable, you simply drag fields from the field list to the appropriate drop zones.

I dragged the OrderQuarter field to the Category field drop zone, the Supplier field to the Series
drop zone, the CategoryName to the Filter drop zone, and the Price field to the Data drop zone,
and I selected the Dairy Products category for filtering the data. Figure 1.28 shows the PivotChart

at this point.
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The PivotChart with fields assigned to its drop zones.

B grytorthwindall
CategoryName ~
| Diry Products
Sum of Price
517,50000
525, =
512
] Supplier =
- s
Il B Cooperntia de Quesos Las Caboas
® Formagz forte s el
7,50000 i
L 1 Ga piturags
W Horses Meierier
55,
52,500.00
2000+ -
011895 QLISSS QL1885 02,1996 03,1554 05,1855 Q41854 09,1985
OrderQuarter =

The next step is to give names to the chart’s vertical and horizontal axes. To name the axes, select an
Axis Title label, open the property sheet, and select its Format tab; enter the name you want to dis-
play for that axis in the Caption property, as shown in Figure 1.29. Repeat for the other axis label.

FIGURE 1.29

Naming the vertical axis of a PivotChart.

CategoryMame ~
| Diry Products

Sum of Price

Properties
General | Fomat | BorderFill
$36,000004| Text format

sueome] B 4 U4

Fonk: Caliori * 11 -
T Fumber:
I Crentason:
w
=
< Fosition -
58,000,00 supplier

56,000.004| Caption
Caption: Sakes|

AxisTitle

OrderQuarter =
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To make the chart’s Legend visible (generally a good idea), click the Legend button in the
Show/Hide group of the Design tab of the Ribbon, as shown in Figure 1.30.

FIGURE 1.30

Making the PivotChart’s Legend visible.

@ o s
b, = i Legend
‘LZ jJ = ool 2

NI ETTD, e wind : Datab o5 | FivalChart

mes) || %1 escer

view || Field
- List

The finished Pivot Chart is shown in Figure 1.31.

FIGURE 1.31

A completed PivotChart.

| Diiry Products

Sum of Price

540,000.00

Axis Title

S8,000,00 ¢ supplier =

56,000.00

61,1885 Q11855 02,1895 02,1996 03,1954 03,1995 04,1954 04,1965

Axis Title

OrderQuarter =

Access 2007 reports have some interactivity, and PivotTables and PivotCharts have almost unlim-
ited interactivity, but both have a serious limitation: the interactivity is available only when you are
working in the Access database; when you send an Access report, PivotTable, or PivotChart to
someone else who doesn’t have Access, say as a PDF file, the recipient gets a read-only image of the
report, PivotTable, or PivotChart, with no interactivity. This may be what you want in some cases;
but if you need to deliver data in a worksheet or chart format that users can interact with, you

need to create an Excel worksheet or chart from your Access data, rather than a report, PivotTable,
or PivotChart.
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=1 See Chapter 3 for information on creating Excel worksheets and charts filled with
- i Access data, and Chapter 12 for information on creating Excel PivotCharts filled with
Access data.

Summary

In this chapter you have learned about some new features of Access 2007, especially those related
to producing Access reports to display data stored in Access tables. But sometimes you need to dis-
play your data in Word documents or Excel worksheets, rather than Access reports; or you may
need to create Outlook appointments, tasks, contacts, or mail messages, using Access as a control
center for working with Office documents.

When you need to produce Word documents, Excel worksheets, or Outlook items, either to make
use of the special features of these Office components or to distribute your data in formats that can
be used by everyone who has Office, you have two options: use the built-in Export selections on
the Ribbon, or write VBA code to create the Office documents and fill them with Access data. The
next three chapters describe how to create Word documents, Excel worksheets or charts, and
Outlook items, and fill them with Access data.
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